LIITE 5 DRIVE MONITOR OHJELMA OHJEET

15.1. Yleista

Drive Monitor on Siemensin kehittama ohjelma Micromaster, Simadyn D, Simoreg,
Simovert ja Siplink kayttjen parametrointiin, kayttbonottoon, monitorointiin  seka
hairidtilanteiden selvittelyyn. Ohjelma toimitetaan kayttéjen mukana. Uusin versio on

vapaasti ladattavissa Internetista Siemensin sivuilta. 24.10.2014 uusin versio on 5.5 SP2.

Ohjelma on kaytettavyydeltaan normaali Windows tyyppinen sovellus. Siemens Step 7
toimintaymparistoon asennettuna Drive Monitoria k&ytetddn Simatic Managerin kautta.
Tietokone johon Drive Monitor ohjelma on asennettu, kytketaan sarjaportin kautta kayton

PMU paneelissa olevaan X300 sarjaporttiin sarjalikennekaapelilla.
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Kuva 70. Kuvassa ndhdaan miten PC jossa asennettuna Drive Monitor ohjelma kytketa&n
kayttoon seka kaapelin kytkenta. (Siemens AG 6RX1700-0BD76 Simoreg DC-Master
Control Module Operating Instructions 2007, 15-1)

15.2. Online yhteyden rakentaminen Simoreg kayttoon

Sarjaliikennekaapeli kytketdan tietokoneen sarjaportista kaytén PMU paneelissa olevaan
X300 sarjaporttiin. Tietokoneissa joissa sarjaporttia ei ole joudutaan kayttamaan USB -
Sarjaportti muunninta. Taman jalkeen kaynnistetddn Drive Monitor ohjelma tydpdydan
ikonista tai kaynnistysvalikosta.
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Kuva 71. Kuvassa Drive Monitor ohjelman ikoni tyopoydalla. (Kuvankaappaus ohjelmasta)

Drive Monitori kaynnistyy aina Offline moodissa. Tasta syysta taytyy joko avata olemassa
oleva dnl-paatteinen maaritettely tiedosto tai luoda uusi tiedosto jossa maaritellaan kaytto
ja sen ohjelmistoversio.

Olemassa olevan tiedoston avaus tapahtuu seuraavasti:

File » Open <olemassa olevan tiedoston nimi>
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Exit

Kuva 72. Drive Monitorin aloitusnakyma. (Kuvankaappaus ohjelmasta)
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Kuva 73. Olemassa olevan offline tiedoston avaus. (Kuvankaappaus ohjelmasta)
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Kuva 74. Nakyma tiedoston avauksen jalkeen. (Kuvankaappaus ohjelmasta)



Uuden tiedoston luonti aloitetaan valitsemalla ensin tehd&&nko se tehdasasettelun pohjalle
vai aloitetaanko puhtaalta poydalta seuraavasti:

File » New » Based on factory setting tai File » New » Empty parameter set

B erion .

File | View Tools Help

Mew 3

Open... CTRL+C

Based on factory setting...
Ermnpty parameter set...

Set up an US55 OMLIME connection ...

Export 3
Import [
Convert

Parameter sets last dealt with [

Exit

Kuva 75. Kuvassa uuden parametritiedoston aloitusvalintaikkuna. (Kuvankaappaus
ohjelmasta)

Taman jalkeen avautuu Drive Properties ikkuna. lkkunassa valitaan kayton ominaisuudet.
Laitteen tyyppi ja versio I6ytyvat kayton arvokilvesta, paakaytoilla tyyppi on Simoreg DC
Master ja versio 02.0. Technology Type valinnassa annetaan olla valinta kohdassa No
technology type. Bus Address eli vaylaosoite tarkoittaa X300 liittimen osoitetta ja on
yleensa 0. PZD lyhenne tarkoittaa prosessitietolohkoa ja niissé kasitelladn ohjaussanoja,
tilasanoja, asetusarvoja, oloarvoja. Tassa tapauksessa lohkojen lukumaaraksi riittaa kaksi,

niiden avulla voidaan ohjata kaytt6a ja antaa asetusarvo.



Unit bype sIMOREG DCMASTER

Shart Type SGV0

Unit version | -

Technology Type Mo technalogy type

Buz Address dizconnect network, conhection

Luantity of FLD

ak Cancel |

Kuva 76. Kuvassa Drive Properties valintaikkuna. (Kuvankaappaus ohjelmasta)

Savein: | . SIMOREG DC MASTER ~| = B cFE-

Mame . Date modified

__|SIMOREG DC MASTER_trmp.dnl 24102014 20:01

<

File name: SIMOREG DC MASTER. tmp

Save astype: |Download Files (*.dnl)

Kuva 77. Kuvan ikkunassa valitaan uudelle parametritiedostolle nimi ja talletushakemisto.
(Kuvankaappaus ohjelmasta)



Valintojen jalkeen tiedosto tallennetaan ja alla olevan kuvan mukainen ikkuna avautuu.
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Kuva 78. Kuvassa péaavalintaikkuna josta valitan tehtavat toiminnot. (Kuvankaappaus

ohjelmasta)

Paavalintaikkuna on samanlainen kuin avattaessa olemassa oleva parametritiedosto.

Sarjaliikenne kaapelin ollessa kytkettynd voidaan Online yhteys kytkea kayttéon joko

File | View | Drive Mavigator Parameters

JE[ v Offline...

2 De Online (Write RAM)
& Dr Online (Write EEPROM)

______ B v Parameterview

valikkorivin  View alavalikosta @ ~ tai pikakuvakkeista

EI R EZ . e . . . .
valikkorivin alapuolelta pikakuvakkeista J:_?_ﬁlji . Valitaan kirjoitus joko RAM muistiin tai
EEPROM muistiin. Jos Online yhteyden muodostus ei onnistu tarkastetaan Tools »
Online settings asetuksista (kuva 79) etta Interface kohdassa on tietokoneen kayttaméa

sarjaportti ja Baud rate on sama kuin kayton parametrilla P701 on maaritelty.
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Kuva 79. Drive Monitor ohjelman liikenndinti asetuksien maarittely. (Kuvankaappaus

ohjelmasta)

15.3 Kunnonvalvonta toiminnot

Drive Monitori ohjelmassa on monipuoliset kunnonvalvonta ja vianhaku toiminnot.
Kaytettavissd on yleinen diagnostiikka, laajennettu diagnostiikka, vayla diagnostiikka,
tyristori diagnostiikka seka trace eli jaljitys toiminta. Toiminnot kaytettavissa vain Online

moodissa.



General Diagnostics

General Diagnostics

Active Warnings | Aktive Fault
No. l Warning Text | About | No. | Fault Text | Faul ... I Fault Time | About |
| Faul History
| No.| Fauk Text | Fault... | Fault Time | About |
2 153 Fauh153 0 0000:0000:0000
Operat. Hours 0 d |0 h 0 s DC Bus Voks 0 v
Firmwareversion V1.63.0 Output Amps 0.0 A
CalcTimeHdroom 60 % Motor Torque 0.0 b4
Drive Temp 30 T Motor Temperat. 0 B
Drive Utilizat. 0 % n{act) 0 min !
Extended Diagnostics

Kuva 80. Kuvassa Drive Monitor ohjelman yleinen vianmaaritys naytté. (Kuvankaappaus

ohjelmasta)

Nayttoruudun ylaosassa on nakyvissd voimassa olevat halytykset, varoitukset seka
vikahistoria. Tupla klikkaamalla hiirella haluttua varoitus- tai vikarivia avautuu ikkuna jossa
lyhyt tarkempi selostus kyseisen hairion syista.

Nayttoruudun alaosasta on luettavissa yleista tietoa kaytdéstd mm. DC-jannite, l&htdvirta,
kayton lampdotila seka pyorimisnopeus.

Klikkaamalla hiirella Extended Diagnostics nappia avautuu laajennettu vianmaarittely
nayttd (kuvassa 81). Naytolta on mahdollisuus valita seuraavat valinnat joiden kautta saat
enemman tieto laitteistosta.

Graphic diagnostics valinnalla saat yleisndkyman kaytostad graafisena toimintakaaviona
ajantasaisiin kayton arvoihin pohjautuen.

Diagnostics Terminal Strip valinnasta ei ollut lisétietoa saatavilla.

Cross Reference Binectors valinnalla saat nakyviin valittujen binectoreiden
keskinaisliitannat.

Cross Reference Connectors valinnalla saat nakyviin valittujen liittimien

keskinaisliitannat.
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Kuva 81. Kuvassa Drive

(Kuvankaappaus ohjelmasta)

Monitor

ohjelman laajennettu vianmaaritys

Bus Diagnostics nayttaa tiedot Profibus-moduulista ja likenndinti parametreista.

naytto.
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Bus Diagnostics

Profibus diagnostics

Node address [3— Current baud rate W Option module type Wv

Configured telegram no. 999 Telegram failure time {10 ms Firmware version Static .

Telegram display Mo telegram type LJ

Received control values/setpoints Sent status/actual values
FZD Value PZD Source Meaning Value

1 0000 hex 1 K0032 StausWord1 [ 4831 | hex
2 0000 hex 2 K000O FiConn0% | 0000  |hex
3 0000 hex 3 K0000 FaConn0% | 0000 | hex
4 [ 0000 hex 4 K0000 FisConn0% | 0000  |hex
5 [ 0000 |hex 5 K000O FConn0% | 0000 | hex
6 0000 hex 6 KO0000 FixConn 0% 0000 hex
7 0000 hex 7 KO00O FixConn 0% 0000 hex
8 0000 hex 8 K0000 FixConn 0% 0000 hex
9 0000 hex 9 K0000 FixConn 0% 0000 hex
10 0000 hex 10 K000O FixConn0% | 0000  |hex
11 0000 hex 11 K0000 FisConn0% | 0000  |hex
12 0000 hex 12 K0000 FixConn 0% 0000 hex
13 0000 hex 13 KO0000 FixConn 0% 0000 hex
14 0000 hex 14 KO0O0D FixConn 0% 0000 hex
15 0000 hex 15 KO000 FixConn 0% 0000 hex
16 0000 hex 16 KO000O FixConn 0% 0000 hex

Kuva 82. Kuvassa vayla diagnostiikka nakyma. (Kuvankaappaus ohjelmasta)

Nayton ylemmassa osassa on tietoa Profibus-modulista sek& liikenndinti parametrit.
Alemmassa osassa nhakyy lahetetty ja vastaanotettu prosessi tieto. Nakyma riippuu
valitusta sanomatyypistd. Valinnan ollessa "No telegram type" kaikki 16
prosessitietokenttaa naytetdan. Jonkin sanomatyypin ollessa Profidrive profiilissa tehtyjen
maarittelyjen mukaisesti valittuna vain kyseisen maaritelyn mukaiset kentat naytetaan.
Prosessitiedon arvot voidaan nayttda heksoina, desimaaleina, prosentteina tai binaarisina,

valinta avautuu napsauttamalla hiirella hex kenttaa.

Trace Functions toiminnalla voit parametrisoija ja maarittda reaaliaikaiset tallennukset
kaytolta saatavista tiedoista. Trace toimintoa varten on myds pikanappain valikkorivin
alapuolella. Trace toiminto aloitetaan valitsemalla Settings painikkeella avautuvassa
ikkunassa halutut asetukset reaaliaikaista nauhoitusta varten. Kaytettavissa ovat Tracel ja
Trace2 nauhoitukset, kumpaankin voidaan valita enimmilld&dn 10 connectoria tai binectoria
nauhoitusta varten. Listaus kaytettavissa olevista connectoreista ja binectoreista 10ytyy
Simoreg DC-Master Control Module Operating Instructions ohjekirjan Iluvusta 12.
Nauhoituksen aloitukselle maariteltava trikkaus- eli liipaisutoiminto jonka ehdon
tayttyminen kaynnistda nauhoituksen. Valintojen teon jalkeen painetaan Start nappia

jolloin Trace alkaa odottaa méaaritellyn liipaisuehdon tayttymista.
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Tracel ja Trace2 nauhoitukset on tallennettava erikseen omiin tiedostoihinsa
nauhoituksen jalkeen haluttaessa tutkia niitda myohemmin. Tracel tallennuksen jalkeen on
siirryttdva Settings valinta ikkunaan (kuva 83), jossa laitetaan tappa Trace2 valintaan,

painetaan OK ja tallennetaan Trace2 nauhoitus kuten aiemmin Tracel nauhoitus.

Record Settings - SIMOREG DC MASTER OF FLINE X]

* Tracel O Trace2 i]select all channels
:_J]KUMS: nactpulseencod v [‘ B St ,
-Record Settings
;_“KEHD?: laMeant/alMator VI
;“K0122: EMFforprecntl vir Recording Interval: FU_-"'ISS.?Z P17
;“Km 90: RFGoutput Vi Pretrigger: |1 %
... |[K0000: Fisk/alueld sl T
KOO00D: Fisvaluel v
—-H o e i Channel... K0030: Controlword1
...|[KD00D: Fisaluel VT : O
.. |[KO00G: Forvaluet v W Tiggerontit |
;“KUUOD: Fis/aluel v (T Trigger Condition: Trigger ¥alue:
... |[K000D: Fisvalue VT c
l1 Dez
- 00071
~ Hex
£ l %
~
" Bin
" Binec
Start: ]Activate once and load data _v_]
BiCo-conversion... I Curve settings: ]keep current :_l
load file... l save file... oK Cancel | Help |

Kuva 83. Kuvassa Trace toiminnon nauhoitus valintanakyma. (Junttila 2009, 50)

15.4 Parametrien tallennus ja lataus

15.4.1 Tallennus
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Kaytt6on otetaan Online yhteys edella olleen ohjeen mukaisesti valitsemalla Online Write
EEPROM valinta. Valitaan File valikosta Upload ja edelleen avautuneesta ikkunasta joko
Basic Device Complete tai Basic Device Changes Only . Valinta riippuu halutaanko

kaikki parametrit talteen vai ainoastaan ne jotka on muutettu verrattuna tehdasasetuksiin.

& DriveMon - [SIMOREG DC MASTER (Adr.: 0) : SIMOREG DC MASTER_tmp] v-"",'_ "-
% View Drive Mavigator Parameters Operate Diagnostics Tools Window Help

B e * B Bl %l Bls| k| 50 2

B Open... CTRL+0O

rive Navigator
Drive Properties |

Save CTRL+S ‘@ s i Assisted
@55 | commissionin
Save As... ; H m\"' e
g
Compare to... [
. Basic functions
Print [
Generate CSV b Gi ) Diirect to parameter
H i—éﬁ Jizt
Export 4 i
Import 3

Learn Database

Download 2

Upload » Update Parameter Set

T Basic Device Complete...

Script-Editor

""" Basic Device: Changes Only...

-4 Close Down Device Technology Module...
d Basic Device and Technology Module...
_;I Parameter sets last dealt with 3
C Exit ‘
lf Syatem |
L m Frontu

Kuva 84. Kuvassa parametrien tallennus valintaikkuna. (Kuvankaappaus ohjelmasta)

Avautuvassa ikkunassa nimetdan tiedosto mihin parametrit tallennetaan ja painetaan Save
valintaa. Taméan jalkeen parametrit luetaan kaytolta tiedostoon. Tallennuksen valmistuttua
saadaan ilmoitus Uppload for file XXXX successfully completed. Taman ilmoitus

kuitatan painamalla OK.

15.4.2 Lataus

Kayttoon otetaan Online yhteys edella olleen ohjeen mukaisesti valitsemalla Online Write
EEPROM valinta. Valitaan File valikosta Download ja avautuvasta ikkunasta Save
EEPROM valinta. Taman jalkeen avautuvassa ikkunassa valitaan oikea dnl-loppuinen
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maarittely tiedosto jossa parametrit ovat ja painetaan Open valintaa. Parametrit latautuvat
kaytdlle Onnistuneen latauksen jalkeen saadaan ilmoitus Download for file XXXX

successfully completed. Taman ilmoitus kuitatan painamalla OK.

Tallennuksessa ja latauksessa  huomioitava  etteivat  vaylaosoitteet  siirry

parametritiedostossa.



